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Entering code at the R console

The bottom-left pane in RStudio is the R console. It's good for experimenting. Code and output here isn't kept anywhere after
you close RStudio.

File Edit Code View Plots

Session Build Debug Profile Tools Help

o - R S Go to file/function ~ Addins ~ R project: (None) ~
@ Exercise_1_2_solution.Rmd =] Environment History Connections =
4 v Q& kit v - @ insert ~ SRun v ‘&~ Sl | ¥ Import Dataset ~ ¥y List « -
98- {r} =4 P b Global Environment ~
99 olympic_100m_data Data
18? g}?mpse(olymp1c_1®0m_data) olympic_10.. 138 obs. of 10 variables
102
1(;0/;—‘ GACA-;W‘A;Wk;;I\ Pt e ST - - - T tees R Markdown Cv
Console =]
T e e g g g NV A ) -
Year = col_double(),
Medal = col_character(),
Name = col_character(),
Nationality = col_character(),
Result = col_double(),
Wind = s K
Time = col_double()
Files Plots Packages Help Viewer P |
) ® = Q / S
> olympic_100m_data o | BT £ 2k
# A tibble: 138 x 10 .
Gender Event Location Year Medal Name Nationality Result Wind Time
<chr> <chr> <chr> <dbl> <chr> <chr> <chr> <dbl> <lgl> <dbl> c O o
M 100M Men Rio 2016 G Usain BOLT JAM 9.81 NA 9.81 12- ¢ 55 oo
M 100M Men Rio 2016 S Justin GATLIN USA 9.89 NA 9.89 . ‘e
M 100M Men Rio 2016 B Andre DE GRASSE CAN 9.91 NA 9.91 = OO :
M 1006M Men Beijing 2008 G Usain BOLT JAM 9.69 NA 9.69 2 .e * 1:0 '
M 100M Men Beijing 2008 S Richard THOMPSON TTO 9.89 NA 9.89 E11- es — c O LT . 0
M 1006M Men Beijing 2008 B Walter DIX USA 9.91 NA 9.91 veoe U o
M 100M Men Sydney 2000 G Maurice GREENE USA 9.87 NA 9.87 . k ol =
M 100M Men Sydney 2000 S Ato BOLDON TTO 9.99 NA 9.99 HH I s .
M 100M Men Sydney 2000 B Obadele THOMPSON BAR 10.0 NA 10.0 10- .:.'l : 1 s
M 100M Men Barcelona 1992 G Linford CHRISTIE GBR 9.96 NA 9.96 ¢ teec 2
# with 128 more rows *e
> ggplot(olympic_100m_data, aes(x = Year, y = Time)) + geom_point() 1890 1820 1950 1980 010
> | Year 2 / 22



Creating a new R Markdown document

You won't need to do this during the course since you'll be working with the R Markdown documents we provide in the
Exercises folder. For your own projects: File > New File > R Markdown...

Mew R Markdown

Document Title: titled
T3 Presentation Author: Cameron Patrick, Melbourne Statistical Cons
7 Shim
%) Shiny Date: 2022-09-18
From Template | Use current date when rendering document

Default Qutput Format:

8 HTML
Recommended format for authoring (you can switch to PDF
or Word output anytime).

PDF
PDF cutput requires TeX (MiKTeX on Windows, MacTeX
2013+ on O35 X, TeX Live 2013+ on Linux).

Word
Previewing Word documents requires an installation of M5
Word (or Libre/Open Office on Linux).

Create Empty Document OK Cance
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R Markdown code chunks

Code chunks in your .Rmd file are for code you want to keep. Make sure there's a blank line above and below the code chunk,
or RStudio may get confused. Click the green "play" button to the right of the chunk to run it. Think of the output as a preview
to help you test your code rather than a permanent record: the "real" output is your knitted HTML file. If you've followed our
setup instructions, output will go in the console. (RStudio default places it directly below the code in the editor.)

File Edit Code View Plots Session Build Debug Profile Tools Help

o -/ CR =i Go to file/function ~ Addins ~ RJ project: (None) ~
@] Exercise_1_2_solution.Rmd P | Environment  History  Connections -
2 7 A @ kit - < *@ nsert ~ +Run ~ | %~ = [ ' E2 Import Dataset ~ y List = -
95 > Markdown document (Ctrl-Enter/Command-Enter or green 'play' button on the > WY enareen Emfiammman ©
96 > right.) Finally, knit the document into an html file and look at the result. Data
o7 NN olympic_1.. 138 obs. of 10 variables
98 -~ {r} =z )

99 olympic_l@@m_datd

100 glimpse(olympic_100m_data)

1ol °

102

103~ ### (d) Looking at columns of numeric data

104

105 > R refers to an individual column within a data frame using the notation
106 > "DATA_FRAME_NAMESCOLUMN_NAME". For example, the column “Time  1in the data
107 > frame ‘olympic_100m_data® would be written “olympic_l00m_data$Time".

108 > -
99:18 Chunk 4 2 R Markdown 2
a Files Plots Packages Help Viewer =

Console = -

M 1UUM Men Sydney 200U B Ubadele IHUMPSUN BAR LU.Y NA 19.0 =[BT =

M 100M Men Barcelona 1992 G Linford CHRISTIE GBR 9.96 NA 9.96
# ... with 128 more rows
> glimpse(olympic_100m_data)
Rows: 138
Columns: 10
$ Gender <:h‘"> IIMH’ IIMH’ IIMH’ IIMH’ IIM|I’ IIMH’ IIMH’ IIMH’ HMH’ HMH’ HMH’ HMH’ HMH‘..
$ Event "100M Men", "1060M Men", "1060M Men", "100M Men'", "100M Men", "lO...
$ Location "Rio", "Rio", "Rio", "Beijing", "Beijing", "Beijing", "Sydney",...
$ Year 2016, 2016, 2016, 2008, 2008, 2008, 2000, 2000, 2000, 1992, 199...
$ Medal IIGH’ IISH’ IIBH’ IIGH’ IISH’ IIBH’ IIGH’ IISH’ HBH’ HGH’ HSH’ HBH’ HGH‘..
$ Name chr> "Usain BOLT", "Justin GATLIN", "Andre DE GRASSE", "Usain BOLT",... 4 / 22
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R Markdown code chunk options

We can include options within the curly braces of a code chunk. The main option you will see utilised in this workshop is the
chunk name or label.

31 - ### (a) Loading the Tidyverse

32

33 Throughout the course, we will be using functions from the "tidyverse’ package.
34 Before you use an R package, you need to lecad it into your session by calling
35 the "library” function. It's a good idea to load all of the packages you need
36 1in a single code chunk at the top of your R Markdown file, like this:

7

38~ "7 {r packages}

39 library(tidyverse

40. °°

41

42 vou can insert new code chunks either by typing in the triple backticks and
43 curly braces by hand, using the #**Insert = R** button in R5tudio, or pressing
44 control-alt-I. (The keyboard shortcut won't work on University owned machines
45 due to software installed by central IT.)

46

47 vou can run a code chunk by pressing the green "play” button on the right of
48 the chunk, or pressing ctrl-shift-enter when the cursor is in the chunk.

49 There are more options for running code in the **Run** button above

50 and to the right of the code editor.

51

52 Code chunks can have a name (like “packages™ above) or they can be unnamed

53 (1like the one below). Code chunks can also have options - for example, the

54 “setup’ chunk at the top of this file has an option "include = FALSE™ which
55 prevents it from showing up in the knitted document.

56

Chunk names are not necessary but have some advantages. Chunk names must be unique and cannot have spaces.
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Knit your document to produce an HTML file

This is the final product of your analysis, produced in a reproducible way: starting with fresh R session with no data or
packages loaded, running all of your code in order. Knit early, knit often.

ersfc/The University of Melbe

Open in Browser Find “S Publish ~

Exercise 1.2 solution

Put Your Name Here

. (
. (

a) Read in the Olympic 100m sprint medal results
b) Looking at a data frame using RStudio
c) Looking at a data frame using code
« (d) Looking at columns of numeric data
e) Looking at columns of categorical data
f) Getting help within R
g) Clearing your R session

(
(
* (
o (
. (

In this exercise, we will be using functions from the tidyverse package. Before you use an R package, you need to load it into
your session by calling the 1ibrary function. It's a good idea to load all of the packages you need in a single code chunk at the
top of your Rmarkdown file, like this:

library (tidyverse)

—- Attaching packages ————————————————————— - tidyverse 1.3.0 —-
v ggplot2 3.3.0 v purrr 0.3.3
v tibble 3.0.0 v dplyr 0.8.5
v tidyr 1.0.2 v stringr 1.4.0
v readr 1.3.1 v forcats 0.5.0
-- Conflicts ————————————————————— - ————————— tidyverse conflicts() --

® dplyr::filter() masks:

stats::filter ()
% dplyr::lag() masks stats::lag()

(a) Read in the Olympic 100m sprint medal results

The file 0lympic 100m results.csv contains information on all Olympic 100m sprint
medalists. Open it in Excel first to see what it looks like, then read it into R using the read csv 6 / 22
function Your'll need ta aive the data frame a name* choose nlumnic 100m dat+a if vou want to o




Loading the tidyverse package

We're going to be using functions from the tidyverse package
throughout this course, so all of our R Markdown files will begin by
loading it:

library(tidyverse)
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Image by Di Cook, Monash University (Twitter).

install.packages("light") 1library("light")

..L‘: '/ /1' /

ul’lﬁil once &

Y
¥ IR

Images sourced from https://www.wikihow.com/Change-a-Light-Bulb
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https://twitter.com/visnut/status/1248087845589274624

R packages and sessions

R packages need to be installed (once) and
loaded (every R session).

Best practice: load all needed R packages in a
single code chunk, near the top of your .Rmd
file.

Don't put the code to install packages in your R
Markdown files or other R scripts.

Use Session > Restart R to give yourself a clean
slate (especially if R is acting weird).
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Importing data from a CSV file

pig_behaviour_data <- read_csv("pig_behaviour_by_time.csv")

The read _csv() function loads data stored in a CSV file into an R
data frame. File names go inside quotation marks "" (or '").

The left-arrow <- stores the result of an R statement in an object
(variable) with a name you choose.

o Always give your object meaningful names.
e Don't use the same name to store two different things in the
same .Rmd file.

Technical note: that's read_csv with an underscore, which is part of Tidyverse; not
read.csv with a dot, which is part of base R. read.csv will often produce slightly
different output, sometimes fails to read CSV files saved by Excel, and is very slow for
big files - so we always recommend read_csv.
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How does R find my data?

Every R session has a working directory.

When knitting a document, this will always be the
folder your .Rmd file is in.

In RStudio generally: could be anywhere,
depending on your settings.

If in doubt: Session > Set Working Directory > To
Source File Location.

Set it in the R terminal; setwd('...")

Check it in the R terminal; getwd()
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Hard-coded paths make colleagues sad

The first linelf your RSeriphiwas
e bl



Examining a data frame using code

glimpse(pig_behaviour_data)

Rows: 280

Columns: 16

$ Pen <dbl> 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 1..
$ Housing <chr> "FC", "FC", "FC", "FC", "FC", "FC", ..
$ Treatment <chr> "HC", "HC", "HC", "HC", "HC", "HC", ..
$ HousTreat <chr> "FC, HC", "FC, HC", "FC, HC", "FC, H..
$ Sex <chr> "M", "M", "M", "M", "M", "M", "M", "..
$ Total_pigs <dbl> 10, 10, 10, 10, 10, 10, 10, 10, 10, ..
$ Time <chr> "15 mins", "15 mins", "15 mins", "15..
$ Time_brief <chr> "15m", "15m", "15m", "15m", "15m", "..
$ Time_hours <dbl> 0.25, 0.25, 0.25, 0.25, 0.25, 0.25, ..
$ Upright <dbl> 10, 10, 8, 10, 10, 10, 10, 10, 10, 1.
$ Aggression <dbl> 0, 0, 1, 2, 0, 2, 60, 0, 0, 2, 0, 0,

$ Chewing_pig <dbl> 2, @, 3, 0, 0, 0, 2, 1, 0, 3, 5, 0,

$ Playing <dbl> 0, 1, 0, 0, 3, 4, 2, 1, 0, 0, 1, O,

$ Vocalising <dbl> 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, .
$ Exploring_pen <dbl> 8, 10, 5, 8, 7, 6, 6, 8, 7, 6, 7, 9,..
$ Nosing_pen <dbl> 0, 0, 0, 0, 0, 0, 0, 0, 1, 0, 0, 0,
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Some more R language

An R expression or statement can be:

e A mathematical calculation, e.g. 24 * 60 * 60
e Saving a result in an object,

€.8. seconds_per_day <- 24 * 60 * 60

Almost anything in R can be saved in an object,

including data frames, statistical models, and plots.

e Calling a function, e.g. log10(seconds_per_day)
o Afew special constructs used for programming
o Any of the above combined (lego bricks!)

You can refer to a particular column of a data frame as
DATA_FRAME_NAME$COLUMN_NAME ,
e.g. pig_behaviour_data$Time

Some R functions are mathematical or statistical. Others
are more computer-y.

mean(Weight, na.rm = TRUE)
mean(x = Weight, na.rm = TRUE)
mean(Weight, , TRUE)

The things inside the brackets are called parameters or
arguments. They are given meaning either by their position
(e.g. first argument to mean is a vector to calculate the
mean of) or their name (e.g. na.rm indicates missing
values should be ignored).

All of the above calls to mean() do the same. Which do you
prefer?
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Getting help

Inside R

Press F1 when the cursor is on a function name in a code
block. (Some laptops, e.g. MacBooks, require Fn+F1.)

?functionname
help("functionname")
help(package = "packagename")
help.search("keyword")

Tip: use these in your R console (used for playing and
experimenting), not your R Markdown file (used for code
and results you want to keep). The last command above
searches all documentation text.

Online resources

Stack Overflow https://stackoverflow.com/
for programming and technical questions

Cross Validated https://stats.stackexchange.com/
for statistical questions

Google search, paying special note to results from the
above.

RStudio Cheatsheets (Help > Cheatsheets > ... or online)

ChatGPT is good for programming questions, including
"how do I" - but can be confidently wrong for conceptual
statistical questions
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Reading data from an Excel file

Use the read_excel() function in the readxl package.

Near the top of your R Markdown, make sure to load the e.g. To read the third sheet of an Excel file:

package:

bird data <- read_excel("bird data.xlsx", sheet = 3)

library(readxl)
e.g. To read the sheet called "Magpies" of an Excel file:

e.g. To read the first sheet of an Excel file:
magpie_data <- read_excel("bird _data.xlsx",

bird data <- read_excel("bird data.xlsx") sheet = "Magpies")
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Extension: .rds files, R's native data format

The .rds file format has a couple of advantages:

e it saves a data frame (or any other data in R) exactly as it is stored
inside R

e it's highly compact so takes up much less space and is fast to load
or save

Load data using the readRDS() function: You probably don't have any .rds files lying around, but

you can save data out of R using the saveRDS() function:
magpie_data <- readRDS("magpies.rds")

saveRDS(magpie_data, "magpies.rds")

This is useful if you have a more complex data set.
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Extension: reading SPSS and Stata data files

The haven package provides functions for reading data files in formats used by other popular statistical software, including
SPSS and Stata.

Load data from a Stata .dta file using read_dta(): Load data from an SPSS .sav file using read_sav():
library(haven) library(haven)
pigeon_data <- read_dta("pigeons.dta") survey_data <- read_sav("survey.sav")
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Including a data frame directly in your code

The tribble() function makes a data frame out of some data directly included in your R code.

It's most useful for small amounts of data.

# A tibble: 5 x 2
postcode suburb_name
<db1l> <chr>

melbourne_postcodes <- tribble(
~postcode, ~suburb_name,

3000, "Melbourne",

3002, "East Melbourne", 1 3000 Melbourne

3003, "West Melbourne", 2 3002 East Melbourne

3051, "North Melbourne", 3 3003 West Melbourne

3205, "South Melbourne"” 4 3051 North Melbourne
5 3205 South Melbourne

)

melbourne_postcodes
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Making vectors

Sometimes it's useful to manually construct vectors (columns) in some way. Here are a few ways to do this:

c(1900, 1926, 1939, 1940, 1941, 1948, 1955, seq(1, 10)
1956, 1957, 1959, 1960, 1964, 2021)
[1] 1 2 3 4 5 6 7 8 9 10
[1] 1900 1926 1939 1940 1941 1948 1955

[8] 1956 1957 1959 1960 1964 2021 seq(1, 20, by = 3)
c("Monday", "Wednesday", "Friday") [1] 1 4 7 16 13 16 19
[1] "Monday" "Wednesday" "Friday" seq(160, 500, length.out = 5)
1:10 [1] 100 200 300 400 500

[1] 1 2 3 4 5 6 7 8 9 10 rep(42, times = 5)

2001:2022 [1] 42 42 42 42 42

[1] 2001 2002 2003 2004 2005 2006 2007 rep(c(1, 2, 3), times = 5)

[8] 2008 2009 2010 2011 2012 2013 2014
[15] 2015 2016 2017 2018 2019 2020 2021
[22] 2022

[1] 1 23123123123123
rep(c(1, 2, 3), each = 5)

[1] 111112222233333 20 / 22



Making data frames out of vectors

The tibble() function makes a data frame (tibble) out of a separate vector for each column.

hipster_postcodes <- tibble(
postcode = c(3055, 3056, 3057, 3070),
suburb_name = c("Brunswick West", "Brunswick", "Brunswick East", "Northcote")

)

hipster_postcodes

# A tibble: 4 x 2
postcode suburb_name
<db1l> <chr>
3055 Brunswick West
3056 Brunswick
3057 Brunswick East
3070 Northcote

S~ WO N e
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Exercise 1.2.
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